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Microsoft Office 2007 New Features 

User interface 

The new user interface (UI), officially known as Microsoft Office Fluent has been implemented in the core 

Microsoft Office applications: Word, Excel, PowerPoint, and Access. These applications have been selected for 

the UI overhaul because they center around document authoring.  

 Office button 

The Office 2007 button, located on the top-left of the window, replaces the File menu and provides access to 

functionality common across all Office applications, including opening, saving, printing, and sharing a file. It 

can also close the application. Users can also choose color schemes for the interface. 

Ribbon 

The Ribbon, a panel that houses the command buttons and icons, organizes commands as a set of Tabs, each 

grouping relevant commands. Each application has a different set of tabs which expose the functionality that 

application offers. The Ribbon is designed to make the features of the application more discoverable and 

accessible with fewer mouse clicks as compared to the menu-based UI used until Office 2007. It is not possible 

to remove the Ribbon, modify it, or replace it with menus with the normal Office 2007 functions. However, the 

Ribbon can be minimized simply by double clicking the active tab’s title. 

Contextual tabs 

Some tabs, called Contextual Tabs, appear only when certain objects are selected. Contextual Tabs expose 

functionality specific only to the object with focus.  Contextual Tabs remain hidden when the object it works on 

are not selected. 

Live Preview 

Microsoft Office 2007 also introduces a feature called Live Preview, which temporarily applies formatting on 

the focused text or object when any formatting button is moused-over. The temporary formatting is removed 

when the mouse pointer is moved from the button. This allows users to have a preview of how the option would 

affect the appearance of the object, without actually applying it. 

Mini Toolbar 

The new Mini Toolbar is a type of context menu that is automatically shown (by default) when text is selected. 

The purpose of this feature is to provide easy access to the most-used formatting commands without requiring a 

right-mouse-button click, as was necessary in older versions of the software. Because the Mini Toolbar is 

automatically displayed, it remains semi-transparent until the mouse pointer is situated on the control in order to 

allow an almost-unobstructed view of what is beneath it. It also appears above the right-click menu when a user 

right-clicks on a selection of words. 

Quick Access Toolbar 
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The Quick Access toolbar, which sits in the title bar, serves as a repository of most used functions, regardless of 

which application is being used, such as save, undo/redo and print. The Quick Access toolbar is fully 

customizable similar to toolbars in previous Office versions. Any command available in the entire Office 

application can be added to the Quick Access toolbar, including commands not available in the Ribbon and 

macros.  

Other UI features 

 Super-tooltips, that can house formatted text and even images, are used to provide detailed descriptions of 
what most buttons do. 

 A zoom slider present in the bottom-right corner, allowing for dynamic and rapid magnification of documents. 

SmartArt 

SmartArt, found under the Insert tab in the ribbon in PowerPoint, Word, Excel, and Outlook, is a new group of 

easily editable and formatted diagrams. There are 115 preset SmartArt graphics layout templates in categories 

such as list, process, cycle, and hierarchy. When an instance of a SmartArt is inserted, a Text Pane appears next 

to it to guide the user through entering text in the hierarchical levels. Each SmartArt graphic, based on its 

design, maps the text outline, automatically resized for best fit, onto the graphic. There are a number of "quick 

styles" for each graphic that apply largely different 3D effects to the graphic, and the graphic's shapes and text 

can be formatted through shape styles and WordArt styles. In addition, SmartArt graphics change their colors, 

fonts, and effects to match the document's theme. 

File formats 

Microsoft Office uses a new file format, called Office Open XML, as the default file format. For example, 

Word documents are now saved using a .docx extension rather than the traditional .doc extension. Word 2007 

can also save documents in the old format which is compatible with previous versions of Word. In addition, 

Microsoft has made available a free add-on known as the "Microsoft Office Compatibility Pack" that lets Office 

2000-2003 editions open, edit, and save documents created under the new 2007 format. 

Office Open XML is based on XML. According to Microsoft, documents created in this format are up to 75% 

smaller than the same documents saved with previous Microsoft Office file formats, owing to data compression. 

Excel and PowerPoint also use the new OOXML file formats.  

PDF 

Microsoft had initially announced that it will support exporting to Portable Document Format (PDF) in Office 

2007. However, due to legal objections from Adobe Systems, Office 2007 does not have PDF support out of the 

box, but offers it rather as a separate free download.  

XPS 

Office 2007 documents can also be exported as XPS documents, via another free plug-in that is also a separate 

download. 
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Microsoft Office Word 2007 

Create professional-looking documents 

Word 2007 provides editing and reviewing tools for creating polished documents more easily than ever before. 

Spend more time writing, less time formatting 

The new, results-oriented Ribbon user interface presents tools to you, in a clear and organized fashion, when 

you need them: 

 Save time and get more out of the powerful Word capabilities by selecting from galleries of predefined 

styles, table formats, list formats, graphical effects, and more. 

 The Ribbon eliminates the guesswork when you apply formatting to your document. The galleries of 

formatting choices give you a live visual preview of the formatting in your document before you commit 

to making a change. 

Add preformatted elements with just a few clicks 

Word 2007 introduces building blocks for adding preformatted content to your documents: 

 When you are working on a document from a particular template type, such as a report, you can select 

from a gallery of preformatted cover pages, pull quotes, and headers and footers to make your document 

look more polished. 

 If you want to customize the preformatted content, or if your organization often uses the same piece of 

content, such as legal disclaimer text or customer contact information, you can create your own building 

blocks that you select from the gallery with a single click. 

Communicate more effectively with high-impact graphics 

New charting and diagramming features include three-dimensional shapes, transparency, drop shadows, and 

other effects. 

Instantly apply a new look and feel to your documents 

When your company updates its look, you can instantly follow suit in your documents. By using Quick Styles 

and Document Themes, you can quickly change the appearance of text, tables, and graphics throughout your 

document to match your preferred style or color scheme. 

Easily avoid spelling errors 

When you are writing a document for others to see, you certainly don't want spelling errors to detract from your 

message or to undermine your professionalism. New features of the spelling checker make it easier for you to 

distribute your work with confidence: 
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 The spelling checker is now more consistent across the 2007 Microsoft Office system programs. 

Examples of this change include: 

o Several spelling checker options are now global. If you change one of these options in one Office 

program, that option is also changed for all the other Office programs.  

o In addition to sharing the same custom dictionaries, all programs can manage them by using the 

same dialog box.  

 The spelling checker can find and flag some contextual spelling errors. Have you ever typed a mistake 

similar to the following? I will see you their. In Word 2007, you can enable the Use contextual 

spelling option to get help with finding and fixing this type of mistake.  

 You can disable spelling and grammar checking for a document or for all documents that you create. 
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Microsoft Office Excel 2007 

More rows and columns, and other new limits 

Excel 2007 supports up to 1 million rows and 16 thousand columns per worksheet. Specifically, the Excel 2007 

grid is 1,048,576 rows by 16,384 columns, which provides you with 1,500% more rows and 6,300% more 

columns than available in the last version of Excel. 

Improved sorting and filtering 

In Excel 2007, you can quickly arrange your worksheet data to find the answers that you need by using 

enhanced filtering and sorting. For example, you can now sort data by color and by more than 3 (and up to 64) 

levels. You can also filter data by color or by dates, display more than 1000 items in the AutoFilter drop-down 

list, and select multiple items to filter. 

Easy formula writing 

The following improvements make formula writing much easier in 2007: 

Resizable formula bar - The formula bar automatically resizes to accommodate long, complex formulas, 

which prevents the formulas from covering other data in your worksheet. You can also write longer formulas 

with more levels of nesting than you could in earlier versions of Excel. 

Function AutoComplete - With Function AutoComplete, you can quickly write the proper formula syntax. 

From easily detecting the functions that you want to use to getting help completing the formula arguments, you 

will be able to get formulas right the first time and every time. 

Excel table enhancements 

In Excel 2007, you can use the new user interface to quickly create, format, and expand an Excel table 

(formerly known as an Excel list) to organize the data on your worksheet so that it's much easier to work with.  

New or improved functionality for tables includes the following features: 

Table header rows   Table header rows can be turned on or off. When table headers are displayed, they stay 

visible with the data in the table columns by replacing the worksheet headers when you move around in a long 

table. 

Calculated columns   A calculated column uses a single formula that adjusts for each row. It automatically 

expands to include additional rows so that the formula is immediately extended to those rows. All that you have 

to do is enter a formula once—you don't need to use the Fill or Copy commands. 

Automatic AutoFiltering   AutoFilter is turned on by default in a table to enable powerful sorting and filtering 

of table data. 

New look for charts 
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In Excel 2007, you can use new charting tools to easily create professional-looking charts that communicate 

information effectively. Based on the theme that is applied to your workbook, the new, up-to-date look for 

charts includes special effects, such as 3-D, transparency, and soft shadows. 

Visual chart element pickers   Besides the quick layouts and quick formats, you can now use the new user 

interface to quickly change every element of the chart to best present your data. In a few clicks, you can add or 

remove titles, legends, data labels, trendlines, and other chart elements. 

Better printing experience 

Page Layout View - In addition to the Normal view and Page Break Preview view, Excel 2007 provides a 

Page Layout View. You can use this view to create a worksheet while keeping an eye on how it will look in 

printed format. In this view, you can work with page headers, footers, and margin settings right in the 

worksheet, and place objects, such as charts or shapes, exactly where you want them. You also have easy access 

to all page setup options on the Page Layout tab in the new user interface so that you can quickly specify 

options, such as page orientation. It's easy to see what will be printed on every page, which will help you avoid 

multiple printing attempts and truncated data in printouts. 
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Microsoft Office PowerPoint 2007 

A new and intuitive look 

PowerPoint 2007 has a new, intuitive user interface called the Microsoft Office Ribbon, which helps you create 

better presentations much more quickly than you could in earlier versions of PowerPoint. PowerPoint 2007 

offers new and improved effects, themes, and enhanced formatting options that you can use to create great-

looking, dynamic presentations in a fraction of the time that you used to spend. You can: 

 Find features and commands in intuitively categorized tabs and related groups. 

 Save time and create better presentations when you select easily accessible formatting options from 

galleries of predefined Quick Styles, layouts, table formats, effects, and more. 

 Take advantage of the live preview feature to review your formatting choices before you apply them. 

Themes and Quick Styles 

PowerPoint 2007 comes with new themes, and Quick Styles that offer you a wide range of options when you 

are formatting your presentations. In the past, formatting a presentation took more time because you had to 

choose the color and style options individually for your tables, charts, and graphics and make sure that they 

matched one another. Themes simplify the process of creating professional presentations. Just select the theme 

that you want, and PowerPoint 2007 does the rest. With one click, the background, text, graphics, charts, and 

tables all change to reflect the theme that you select, ensuring that all elements in your presentation complement 

one another.  

Custom slide layouts 

With PowerPoint 2007, you are no longer confined to prepackaged layouts. You can now create your own 

custom layouts that can contain as many placeholders as you want; elements such as charts, tables, movies, 

pictures, SmartArt Graphics, and clip art; and even multiple slide master sets with custom layouts for different 

slide topics. You can also now save the layouts that you customize and create for future use. 

New and improved effects 

You can add effects like shadow, reflection, glow, soft edges, warp, bevel, and 3-D rotation to shapes, SmartArt 

graphics, tables, text, and WordArt in your PowerPoint 2007 presentations. You no longer have to hire a 

designer to create these effects for you. Instead, you can use professional, easy-to-modify effects yourself 

directly in PowerPoint. 

Presenter view 

By using two monitors, you can run your PowerPoint 2007 presentation from one monitor (at a podium, for 

example) while your audience views it on the second monitor. Presenter view offers the following tools to make 

it easier for you to present information: 

 You can use thumbnails to select slides out of sequence and create a customized presentation for your 

audience. 

 Preview text shows you what your next click will add to the screen, such as a new slide or the next bullet 

in a list. 
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 You can black out the screen during your presentation and then resume where you left off. For example, 

you might not want to display the slide content during a break or a question and answer period. 

Microsoft Office Access 2007 

Faster ways to get started 

Access 2007 provides templates with which you can easily create databases, tables, and fields. In addition, there 

are new views and design tools to help you create new database objects and to work with data. 

Database templates for building complete applications 

Access 2007 includes a suite of professionally designed database templates for tracking contacts, tasks, events, 

students, and assets, among other types of data. You can use them right away or enhance and refine them to 

track information exactly the way that you want. Use the Getting Started with Microsoft Office Access page, 

which appears each time that you start Access 2007, and quickly get started creating your database by opening 

one of the templates. 

Improved Datasheet view 

Creating tables is now easier — just click Table on the Create tab and start entering data. Access 2007 

automatically determines the best data type for each field so that you are up and running in no time. The Add 

New Field column shows you just where to add a new field — and if you need to change the data type or 

display format of a new or existing field, it is easy to do so by using the commands on the Ribbon, which is part 

of the Microsoft Office Fluent user interface. You can also paste data from Microsoft Office Excel tables into a 

new datasheet —Access 2007 creates all of the fields and recognizes the data types automatically. 

New Layout view helps speed the design of forms and reports 

Use Layout view to make design changes while you view data in a form or report.  For example, you can add a 

field to the design grid by dragging a field from the Field List pane, or you can change properties by using the 

property sheet. Layout view supports the new, stacked and tabular layouts — groups of controls that you can 

move and resize as a unit so that you can easily rearrange fields, columns, rows, or whole layouts. You can also 

remove a field or add formatting easily in Layout view. Design view still remains available for more detailed 

work, and it has also been enhanced to support stacked and tabular layouts. 

Results-oriented user interface 

The new results-oriented user interface — the Microsoft Office Ribbon — makes it easy for you to work in 

Access 2007. Commands and features that were often buried in complex menus and toolbars are now easier to 

find on task-oriented tabs that contain logical groups of commands and features. Many dialog boxes are 

replaced with galleries that display the available options, and descriptive tooltips or sample previews are 

provided to help you choose the right option. No matter what activity that you are performing in the new user 

interface — whether it is creating a report or entering data — Access presents the tools that are most useful to 

successfully completing that task. 

Navigation Pane   
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This pane lists and provides easy access to all of the objects in the currently open database. Use the Navigation 

Pane to organize your objects by object type, date created, date modified, related table (based on object 

dependencies), or in custom groups that you create. Need more space to work on your form design? You can 

easily collapse the Navigation Pane so that it takes up little space, but still remains available. The Navigation 

Pane replaces the Database window that was used in versions of Access earlier than Access 2007. 

Tabbed objects   

Your tables, queries, forms, reports, and macros are displayed as tabbed objects in the Access window.  By 

clicking the object tabs, you can easily switch between various objects. 

Create tab 

Use the Create tab to quickly create new forms, reports, tables, Microsoft Windows SharePoint Services lists, 

queries, macros, and modules. If you selected a table or query in the Navigation Pane, you can create a new 

form or report based on that object in one click by using the Form or Report command. The new forms and 

reports that are created by this one-click process are more visually appealing and immediately useful, because 

their design has been upgraded. Automatically generated forms and reports get a professional looking design 

with headers that include a logo and a title. In addition, an automatically generated report also includes date and 

time information, and informative footers and totals. 

New views: Report view and Layout view 

Two new views let you work with forms and reports interactively. By using Report view, you can browse an 

accurate rendering of your report without having to print or display it in Print Preview. To focus on certain 

records, use the filter feature, or use a Find operation to search for matching text. You can use the Copy 

command to copy text to the Clipboard, or click the active hyperlinks displayed in your report to follow a link 

in your browser. 

Report view adds the ability to browse, but Layout view lets you make design changes while you browse. You 

can use Layout view to make many common design changes while you view data in a form or report. For 

example, add a field by dragging a field name from the new Field List pane, or change properties by using the 

property sheet. Layout view supports the new, stacked and tabular layouts — groups of controls that you can 

manipulate as one so that you can easily rearrange fields, columns, rows, or whole layouts. You can also 

remove a field or add formatting easily in Layout view. Design view remains available for more detailed work, 

and it has also been enhanced to support layouts. 

New data types and controls 

Access 2007 includes new and enhanced data types and controls that allow you to store more types of data, and 

you can enter them more easily. 

Attachment fields for files 

The new Attachment data type lets you easily store all types of documents and binary files in your database 

without any unnecessary growth in database size. Access 2007 automatically compresses attachments, when 

possible, to minimize space usage. Do you need to attach a Microsoft Office Word 2007 document to a record 

or save a series of digital pictures in your database? Using attachments make these tasks much easier. You can 

even add multiple attachments to a single record. 
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Enhanced sorting and filtering tools 

Suppose that you need to quickly find a matching value or sort a column of data. The new Access 2007 

AutoFilter feature augments already powerful filtering abilities so that you can quickly focus on the data that 

you need. You can easily select from the unique values in a column, which is useful for situations when you 

can't recall the name that you need, or you can sort the values by using context menu options in plain language, 

such as Sort Oldest to Newest or Sort Smallest to Largest. 

The most common filter options are readily visible in menu commands, or you can use quick filters to limit 

information based on the data that you enter. Quick filter options automatically change based on the data type 

so that you will see sensible choices for text, date, and numeric information. 

These new filtering and sorting features are designed to provide you with a consistent experience, whether you 

are using Access 2007 or Excel 2007. 

Enhanced security 

In order to help make Access 2007 more secure and to maintain consistency with other 2007 Office release 

products, Access 2007 includes new and improved security features. Unified trust decisions are integrated with 

the Microsoft Office Trust Center. Trusted locations make it easy to trust all databases in secure folders. You 

can load an Access 2007 application with code or macros that are disabled to provide a more secure, sandboxed 

(that is, unsafe commands can't be run) experience. Trusted macros are run in Sandbox mode. 
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Microsoft Office Outlook 2007 

Instant Search    

Outlook 2007 provides a new fast way to find your information, no matter which folder it is in. Outlook now 

uses the same search technology that Microsoft Windows does, to deliver fast results regardless of mailbox size. 

In addition, an improved visual design displays each individual result of your search immediately, as soon as it 

is available, while the search is still running.. 

Color Categories    

New Color Categories give you a quick, visual way to customize items and to distinguish items from one 

another, making it easy to locate information. Suppose, for instance, that you want to assign a color category to 

all items related to a certain project. You can add the same color category to e-mail, calendar, and task items so 

that you can easily locate all items from that project at a glance. When you need to find the information later, 

you can search and sort by Color Categories to quickly and visually identify what you are looking for.  

Results-oriented user interface    

Outlook 2007 has a redesigned user interface that makes it easier and more intuitive for you to compose, format, 

and act on your e-mail. You can now access all of the rich features and capabilities in Outlook in at one easy-to-

find location within your e-mail message. 

Attachment previewing    

Using the new Attachment Previewer, you can view your attachments from within the Reading Pane by making 

only a single click. This improvement saves you time and allows you to view attachments in context with the e-

mail message.  

Minimized Navigation Pane    

The Navigation Pane can now be minimized into a vertical button bar, to provide you with a larger work area 

while allowing quick access to Favorite Folders and other views.  

To-Do Bar    

The new To-Do Bar integrates your tasks, e-mail messages flagged for follow up, upcoming appointments, and 

calendar information in one convenient place. The To-Do Bar gives you a consolidated view of your priorities 

for the day.  

Flagging mail for follow-up    

Flags are now more useful throughout Outlook. You can use a flag to quickly create a follow-up item that can 

be tracked in the To-Do Bar, in your Inbox, and even in Calendar. They are also still handy for setting 

reminders for yourself and other people.  

Calendar Snapshots    
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You can send your calendar to anyone in an e-mail message. The recipient can open the calendar either in their 

Web browser or in Outlook.  

Calendar overlays    

Viewing calendars in overlay mode enables you to navigate multiple calendars on top of one another, making it 

easier to compare your calendar with a coworker's or team calendar to find a free time to meet.  

Junk E-mail Filter/phishing protection    

Outlook 2007 features an improved Junk E-mail Filter that sorts out even more unwanted e-mail messages that 

before. There is also new protection against phishing (the use of fraudulent e-mail messages that might trick you 

into divulging personal information). Outlook 2007 tracks suspicious e-mail messages, and helps protect you by 

automatically disabling links within such messages until you approve them. You are warned from within the e-

mail message of potentially threatening or malicious sites.  
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